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HyGEARS update –29 November 2017 - Build 405.90 - 462 
 

 

1) In 5Axis, the 5Axis CnC window is not imposed to be in front of the Graphic Parent window anymore, and 
2 icons appear in the Tool Bar: one for HyGEARS itself, the other for the 5Axis CnC window. Therefore, the 
5Axis CnC window can sit anywhere on the screen. If the 5Axis CnC window is hidden by the Graphic Parent 
window, it can be accessed through the icon on the Windows tool bar. 
 

 
 
2) In 5Axis, all Tool definitions now include entry fields for Tool ID and TLU ID. The Tool ID and TLU ID are 
fields used in the Operation to inform the controller of the tool used.  
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
3) In 5Axis, Chamfer Tool Side / Toe / Heel, HyGEARS now detects if a Chamfering End Mill tool is used. A 
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Chamfering End Mill tool [Cone Tool for short] is an End Mill with a 45° to 90 ° cone angle at the tip, as 
shown below. 
 

 
 

The Cone Tool  is described as a usual End Mill, except that the Diameter is expected to be nearly zero (0.050 
mm, figure below), the Edge Radius is zero, and the Cone Angle ranges from 45° to 90°.   
 

 
 

Whenever a Cone Tool is detected, in the Chamfer Toe / Chamfer Heel cycles, HyGEARS offers a different set 
of entry fields, as follows: 
 

• Depth: depth to which the chamfer is to be cut; 

• S.Length: distance along the edge of the Cone Tool; 

• Pivot A.: angle to pivot the Cone Tool out of the gap (+ value) or into the gap (- value); 
 

 
 



 
5 

 
 

 
 

 
 

4) In 5Axis, Chamfer Toe / Chamfer Heel, HyGEARS offers Stock for both Fillet and Flank, such that the 
location of the tool can account for the fact that, for example, the Flank may have a +Stock, while the Fillet 
has a protuberance, and thus –Stock. 
 
In addition, the Start step is now imposed as 0.  
 
Finally, when the Output button is clicked, the starting tooth flank is based on the CW or CCW spindle 
rotation as defined in the Operation tab. 
 

Pivot A. 

Depth S. Length 
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5) In 5Axis, Tip Chamfer, Tool Side, is now allowed with a CoSIMT. 
 

 
 
 

6) In 5Axis, Process tab, addition of the No Comments switch, which allows imposing or disabling comments 
globally to all the Operations of a given Process, without having to edit each individual Operation. 
 
Also, the Output button has been moved such as to stand out and be more visible. 
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7) In 5Axis, Process tab, the Summ button now prints out the Process Summary in column form rather than 
the original linear form. This allows addition of more info, and makes for easier consultation of each step. 
 

 
 
 
8) In 5Axis, Machine/Tool tab, it is now possible to selectively display the machine’s Turn Table on which the 
work piece and its supporting arbor are installed. 
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The Turn Table dimensions are defined in the machine’s data, Controller-Machine Head tab:  
 

 
 
 

9) In 5Axis, when animating (Anim button) or single stepping (+/- button) an Operation HyGEARS now checks 
the min and max X Y Z A B values and outputs a balloon in the lower right corner of the screen if any of these 
exceeds the machine limits. 
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For this warning to be displayed, the machine’s limits must have been defined by editing the desired 
machine and entering the values in the Controller-Machine Head tab, Machine Limits section, as shown 
below. 
 

 
 
Since HyGEARS is distributed with the master Machine definition file, each time HyGEARS is installed, the 
current Machine file is updated and therefore, any machine limits entered by a user should be transferred to 
Involute Inc. in order to maintain the master Machine file. 
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10) In 5Axis, for Coniflex gears cut with a Coniflex Dish type cutter, the tool can now be withdrawn to either the 

Work Apex or along the Tool Axis.  

 
For example, in AC type machines, retracting to the Work Apex is usually not an issue because of a large volume; 
this is not so in a Gleason Phoenix machine where travel along the work piece is limited, and then withdrawing 
along the Tool Axis becomes compulsory. This has limited effect on cycle time, and is usually based on what the 
machine can allow. 
 

 
 
 

11) In 5Axis, the Non Gen Plunge cutting cycle (Face Mill cutter), the Retract Factor now relates to tooth depth at 
Heel rather than at mid-face. 
 
12) In 5Axis, HyGEARS now estimates the Torque and Power required for a cutting operation. This is subdivided in 2 
data pages: 
 

Operation page: Next to the Spindle RPM, tool cutting data is given; when the Spindle RPM or Cutting 
Feed is modifed, Vc and fz are updated (fz is based on the largest of the enabled Cutting 
Feeds). 

 

• Vc:  cutting speed, i.e. tangential speed at the tool OD; 

• fz: feed / tooth, i.e. size of the cutting bite / tool blade or flute; 

• ae: working engagement, i.e. shape of the cut; may be disabled and replaced by "N/A" 
when Not Applicable, for for Face Mill tools; 
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• Kc: material constant; see tables in the documentation  
(https://www.sandvik.coromant.com/en-
us/knowledge/milling/formulas_and_definitions/formulas). 

 

 
 

Cycling Time page: the estimated average spindle Torque and Power is displayed below the cycling time. 
Cutting torque and power are based on the relations provided by Sandvik.  

 

 
 

13) For Spur/Helical gears, in the Geometry Summary Editor (Pin / Gea function buttons), the X Factor (i.e. the 
Profile Shift factor) can now be edited. This allows adjusting the X Factor to reach a target tooth thickness. 
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In addition, whenever the Minor Diameter (i.e Root Diameter) or Major Diameter (i.e. Outside Diameter) is 
changed and the Apply button is clicked, the cutting blades are adjusted in order to produce the required 
diameters. 

 
 

 
 

14) For Face gears (gear member only), the Fc.Xp, C.Xp and MD values are now displayed in the Blank Child 
window. These are used to locate the pinion axis of rotation in reference to the Face Gear. 

 
 
 
 

15) In Corr-RE display mode, addition of the “ThStk” function button. This is used to enter the desired Stock 
used to define the CMM Nominal target (CMM display mode). 
 
For example, suppose the CMM Nominal target has been defined with +0.025 mm stock on each flank, since the 
targeted cut is roughing. When measuring, the requested stock will be accounted for. However, when importing 
the CMM output into HyGEARS, the CMM output is always compared to the nominal tooth, i.e. without any 
stock. 
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An error will therefore appear in the comparison because of the difference in stock between the nominal and 
actual teeth, as is shown, left figure above. If the Stock used in defining the CMM Nominal is entered, as in the 
right figure above, then no error is generated. The Stock value is also shown in the display – right figure above. 
 

 
16) In the Graphic Summary selection window, GSum function button, it is now possible to define whether the 
Roughing machine settings are outputted or not. By default, this option is unselected. 
 

 
 

17) In ISO-10300, load cycles can now be entered such as to estimate the cumulative damage caused by contact 
and bending stresses. 
 
Load cycles are entered as a series of pinion Torque, pinion RPM and # Hours runtime. Up to 20 values can be 
entered. 
 

Stock  

NO comparison error Comparison error 
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Output gives the results for each load cycle, and the cumulative Contact and Bending damage at the end of the 
document. 
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18) If the Network option has been purchased, and a user attempts to run HyGEARS, a message notifying the 
user that no license is available is displayed when all licenses are currently used; the IP address of the last user 
to log into HyGEARS is also displayed, such that one can ping this user to check for how long he will be busy with 
HyGEARS. 
 

 
 

19) When developing Cyclo-Palloid gear sets (BPat function button), the cutting cycle is now seen as a semi-completing 

process and therefore, machine settings for both the IB and OB flanks are available. This also means that the Vertical 

Position of the Bearing Pattern on each tooth flank can be controlled individually. 

  

 

20) When using the File -> Save As command to save an existing gear set under a new name or in a different folder, 

HyGEARS checks to see if the geometry is saved in a different folder and, if so, HyGEARS copies the Operations.fil and 

Processes.fil files from the origin folder to the destination folder. 

21) Improvement in the stability of the RemT  function (Remove Tilt) where cutter tilt is replaced by a combination of 

Ratio of Roll and Helical Motion in generated gear sets. 

22) Addition of the DXF function button [optional] to the Geometry display mode. The DXF function exports the different 

aspects of the tooth of the selected member: 

192.171.1.68 
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• the Tooth Section, 

• the Gap Section, 

• the 3D Tooth Model (with 1 to Z  teeth). 
 

The Tooth and Gap sections can be obtained: 

• at Toe, 

• at Mid Facewidth, 

• at Heel. 

Furthermore, the Tooth and Gap sections can be obtained: 

• In the Transverse plane, with the axial coordinate Z = 0, 

• In the Transverse plane, with the actual axial coordinate Z, 

• In the Normal plane. 

 

23) Addition of Tip Chamfer to the Blank definition. The Tip Chamfer value is assumed to bisect the tooth flank and 

topland in equal parts to the given depth. It is used solely  for kinematic purposes, i.e. to determine how large the 

chamfer should be in order to prevent tip to fillet interference, and therefore has no connection with any Operation in 

5Axis mode. 



 
17 

 

 

24) When creating a New Geometry, the various gear types offered in HyGEARS are now displayed in an alphabetically 

sorted  list. 

 

25) When creating a new Face Gear geometry, the desired Backlash is now offered as an input field, as shown below. 
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If the entered Backlash is less or equal to zero, HyGEARS will use as is the given XFactor (i.e. Profile Shift factor) for 

the Gear member. If the entered Backlash is greater than zero, then HyGEARS will adjust the XFactor for the Gear 

member to reach the desired Backlash. 

26) In the Corr-RE display mode, addition of the “Exprt” function button to the Pinion and Gear groups. 

 

The “Exprt” button calls the CMM Nominal Format window, figure below, where one can select the format in which 

the currently loaded CMM file will be exported  (can be a Nominal or an actual CMM output file). 
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This means than the coordinates of the currently loaded CMM file will be exported in the selected format (GAGE is 

selected in the figure above), whatever the format the CMM coordinates came in. Since the tooth flank normal 

vector at each point of the original CMM file are not conserved - often, they simply are not given in a CMM output 

file - HyGEARS will provide normal vector values based on the machine settings of the digitized tooth, Pinion or Gear. 

Therefore, slight differences in normal vector components can be expected if there is a significant difference 

between the digitized tooth and the CMM data. In practice, the noted differences in normal vector components are 

at the 2nd or 3rd decimal, and are therefore rather insignificant in effect. 

27) Addition of the VH>> function to the TCA mode. 

 



 
20 

The VH>> function is used during Bearing Pattern Development to convert actual E, P and G V-H Settings into 
machine settings changes used to produce the desired Bearing Pattern. This avoids using Gleason’s Proportional 
Changes. 
 
At the manufacturing stage of a gear set, it is common practice to use surface measurement to quantify the 
difference between the theoretical tooth surfaces and those  produced on actual machines, which requires the use 
of a Coordinate Measurement Machine, or CMM. 
 
When a CMM is not available, the V-H test is used, where the pinion and gear members are operated under a light 
load using marking compound to locate the Bearing Pattern on the tooth flank and modify the relative operating 
positions of the pinion and gear member until the desired Bearing Pattern is obtained. 
 
Once the E P G positions needed to produce the desired Bearing Pattern are found, they must be converted to 
actual pinion machine settings changes. The VH>> function is used to convert the E P G values of the V-H test into 
actual machine settings.  
 
As for Corrective Machine Settings, before calculating any VH>> machine settings changes, the Nominal Summary 
must be defined. This is done by HyGEARS upon confirmation by the user the first time the VH>> machine settings 
changes algorithm is accessed (see figure below).  
 
Once the Nominal Summary has been defined, all VH>> machine settings changes will be calculated in reference to 

the defined Nominal. 

 
 
The E P G values required for the VH>> function are entered through the following V-H Settings window, which 
is displayed after the above confirmation has been done: 
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The E P G values and signs are as recorded on the VH tester, i.e.: 
 

P+:  when the Pinion moves away from the Xp 
G+: when the Gear moves away from the Xp; 
E+:  when a LH Pinion goes up (the movement is considered on the Pinion). 
 

In short, the VH>> algorithm uses the Nominal Summary to evaluate the differences between the theoretical 
and actual (meaning under E, P and G changes) Bearing Pattern location, and bases the modification of each 
machine setting on the amount of change in Bearing Pattern position.  
 
Each machine setting modification is then added to the latest Summary version in the history of the considered 
pinion. It is therefore imperative that the geometry data file be saved on disk after VH>> machine settings 
changes have been calculated and applied. HyGEARS automatically proposes to do so. 
 
HyGEARS maintains a history of the different VH>> machine settings changes that were calculated for the 
pinion, provided the geometry is saved after VH>> machine settings changes have been calculated and applied. 
The Bearing Pattern Development History can be reset, or completely erased, using the Main Menu Edit->Reset 
Bearing Pattern History function. 
 
Up to 7 VH>> machine settings changes steps are currently allowed in HyGEARS, which should be sufficient for 
most applications. 
 
 

Example:  
 

A 9x37 RH spiral bevel gear set is being developed. The gear member is already cut - but differs from the 
original design as shown below - and the pinion needs to be cut to mesh correctly with the gear.  

 
 

 
The target contact patterns appear below: 
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Upon running the gear set on the VH tester with the design MD (mounting distance), the contact patterns 
came out as show below, i.e Toe heavy on the gear convex flank, and a bit towards Heel on the gear 
concave flank: 

 

 
        

In order to center the contact pattern on the tester, the following E P G values were required, which yielded 
the contact patterns shown below: 

 

• E: -0.62 mm 

• P: +0.70 mm 

• G: -0.35 mm 
   

 
Using the VH>> function, the above values were entered in HyGEARS, a new pinion Summary was obtained 
and used to cut the pinion, and the following contact patterns were obtained on the gear: 
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Clearly, the contact patterns went where desired by the developer at the 1st iteration.. The fact that the 
gear member was not cut to target does affect the precision of the solution, but does not prevent obtaining 

a good solution. Doing a 2nd iteration yielded the following result: 
 

     
 
Here, what would be needed is to : 

 

• Reverse Engineer the gear to the CMM data using the HyGEARS R.E. function, 

• develop the contact pattern by modifying the pinion machine settings using the HyGEARS BPat 
function, 

• use the HyGEARS VH>> function as explained above. 
 
 

Doing so, the results shown below are obtained after 1 iteration. Clearly, the results converge very quickly. A 

2nd iteration could be applied  in order to improve a bit more the contact pattern on the Concave flank. 
 

    
 

28) Addition of a 2nd manufacturing method for Beveloid gears [external].  

Up to HyGEARS Build 405.80, [external] Beveloid gears were based on a Pivoted Work, i.e. the work piece axis would 

be pivoted by the specified pitch angle such that the tool would move in a straight direction that would be at an 

angle to the axis of the work.  

From Build 405.90, figure below, the Plunging Tool option is also offered where the axis of the work is installed in the 

machine as if cutting a spur gear, but the tool plunges progressively as the tool advances along the face width: in 

effect, the Profile Shift factor changes continuously as the tool moves along the face width. 

The Pivoted Work approach produces a gear set which is slightly not-conjugate. In both cases, Pivoted Work  and 
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Plunging Tool, the helix and blades angles of the pinion are adjusted in order to center the Contact Pattern. 

 

In addition, the Pitch Angle of both the Pinion and Gear can now be entered such that both members, or only 1, can 

be Beveloid, and can be of same value but opposite signs such that the axes of the Pinion and Gear are //, as is shown 

in the figure below. 

 

Finally, a Shaft Angle and a Pinion Offset can be imposed. For example, figure below, the Pinion and Gear Pitch 

Angles are respectively +6 and -6 deg, and a 20 deg. Shaft Angle is imposed. The resulting parts have // axes in one 

plane (left, below), and non // axes in the perpendicular plane (right, below). 
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As another example, for the same Pinion and Gear Pitch Angles and Shaft Angle, the left gear set below has no Pinion 

Offset while the right gear set has a 10mm Pinion Offset. 

   

0 mm Pinion Offset   10 mm Pinion Offset 

29) Introduction of Internal Beveloid gears [new HyGEARS option] where either the Pinion, Gear or both can be 

Beveloid, and cut either with a Pivoted Work or Plunging Tool like external Beveloid gears. 

For example, left figure below, the Pinion has a -5 deg. Pitch Angle while that of the Gear is +5 deg. The end result is a 

gear set with // axes where shifting the Pinion axially allows backlash control. By contrast, right figure below, both 

the Pinion and Gear have the same Pitch Angle, and the result is a gear set where the axes are not //; however, 

shifting the pinion axially still allows backlash control. 
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HyGEARS update – 09 September 2019 - Build 406.00 - 463 
 
1) HyGEARS can now be used in German, thanks to the work of Dr. Ing. Joachim Thomas of ZG Hypoid (see www.zg-

hypoid.de). Although HyGEARS is not entirely translated in German, it is substantially so, and this will improve as time 

allows. 

To change to German, click on the menu sequence Edit -> Configuration to access the General data page and select 

Deutsch. When the language has been modified, HyGEARS must be restarted; a message is displayed to that effect. 

 

 

 

2) For Hypoid pinions, the effective face width for the LTCA Bending Stress is now calculated slightly differently such 

as to produce results more consistent with FVA’s Becal 6. 

3) For all supported gears, the calculation of the tooth form factor used for the bending stress has been reviewed to 

be more general, and especially to be closer to the original Lewis Parabola. 

In the following figure,  

• N is the local tooth flank normal vector for one given position on the Path of Contact (PoC); 

• the green outline is the intersection between the plane in which vector N lies and the tooth itself; 

• at the given position along the PoC, EpCnt is the tooth thickness on the green outline; 

• vVector N is extended until it crosses the center of the tooth;  

• the Lewis Parabola (yellow dashed line below) is then calculated from this position, i.e. it is centered at the 

upper end of dimension h (in red) and is tangent to the fillet where EpBase touches the fillet contour.  

• dimension x is an intermediate value used in the calculation of the tooth form factor. 
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4) In the Strength Calculation of the GSumm output, the TOOTH LOADS now have either a + or – sign in order to be 

consistent with the KISSSoft output. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tooth contour 

Lewis Parabola 

Normal Vector 
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5) In the Strength Calculation of the GSumm output, addition of the “TOOTH LOADS – Based on REFERENCE angles” 

where the REFERENCE angles are the pressure and spiral angles that are either calculated when a New Geometry is 

created, or else obtained when importing from a KIMoS or a Gleason Spa file.  

 

 

6) In Machine mode, when accessing 5Axis through the [5Axis] button, HyGEARS now:  

• maximizes the display Child Window for the selected member, pinion or gear, and 

• disables the function buttons for the non-selected member, gear or pinion, 

such as to give more display area and avoid clicking on a wrong button or in the non-selected member’s display area 

whence HyGEARS will exit the current 5Axis session. When the 5Axis window is exited, the Child Window returns to its 

normal 2 Child Window state. 

 

7) In 5Axis, for CoSIMT tools, the Body Dimensions are now accessed from a different window through the Body 

Dimensions […] button, as shown below. Body Dimensions include: 

• Arbor Diameter; 

• Tool Length; 

• Number of Blades; 

• Body Outside Angle; 
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• Body Inside Angle. 

The 2 last values were previously taken as being the same as the Outside Angle and Included Angle; they are now 

variables that can be changed to suit a specific CoSIMT body geometry. 

 

 

8) In 5Axis, it is now possible to select the “Rock Me [babe]” cycle for either of the flanks or both; to select only one 

flank, it is simply required to make the opposite flank as “None”. In this case, the movement will be only on the 

selected flank. 
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9) In 5Axis, Process tab, it is now possible to over-ride the Apex Location imposed in individual Operations of a given 

Process by entering the desired value in the Apex Loc. field, as shown below. When the Process is saved, this value is 

saved such as to be available the next time the same Process is used. 

 

 

10) In 5Axis, the Short Header now includes the Apex Location entry such as to allow the engineer/operator ensure 

Operations within a Process all use the correct value. 

 

 

 

11) In 5Axis, all the CnC cycles are now enabled when roughing with a CoSIMT. 
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12) In 5Axis, addition of the Feed Rate to the Haas Horizon non-generated cycle output where the plunging rate is 

therefore controlled. 

 

 
 

13) In 5Axis, slight modification to the Return Trip to give a more predictable path when in Work coordinates: the 

retracted tool position at the end and beginning of the cutting cycle are used to establish start and end positions of the 

tool; the axial location of the tool is then interpolated linearly over the requested # Steps in the Return Trip, and when 

reaching the start position, the other coordinates and angles are imposed. 
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14) In 5Axis, the Process summary - [Summ] function button – now adds the Feeds used for the cutting cycle. 

 

 
 

15) In 5Axis, the [Save] button has been added to the action buttons at the bottom of the 5Axis window. The [Save] 

button saves the current Operation and eliminates the need to always go back to the Operations page to be able to save 

any change made on another page. 

 

 
 

16) In 5Axis, when using the MultiPass cutting cycle, the current “Step #” and “Pass #” are added to the coordinates, 

along with the # of passes required for the considered Step level. For example, figure below, the current Step level is 
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given as [Stp 1/9], which means there are a total of 9 steps considered, and the tool is at Step 1; the current Pass # is 

given as {Pass 1/6} which means there are 6 passes required at Step 1, and the tool is currently at Pass 1. 

 

 
 

 

17) In 5Axis, when a requested tool is not found, a warning message is displayed where the missing tool name is given, as 

shown below.   

 
 

In addition, in a Process Summ or in the Short Header, the “!WRONG TOOL NAME!”  string replaces the requested tool 

name. 

Step level Pass # 
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18) In 5Axis, for CoSIMT tools, HyGEARS now offers the Plunge Generation cutting cycles, one for each flank. Plunge 

Generation moves the CoSIMT from Tip to Fillet along the profile of the tooth at the requested position along the 

tooth flank. 

 

As before, the tooth flank is subdivided as imposed by the “# Facewidth Pts”; however, in Plunge Generation, it is 

possible to instruct HyGEARS to start and finish at specific locations, such that the same plunge generation 

movement used for Coniflex gears can be used with CoSIMT tools.  

 

 
 

For example, figure below, the tooth is subdivided in 7 points (# Facewidth Pts); Start and End points are 4, and 

therefore, the path will be in the center of the tooth (red arrow). Toe and Heel clearances have conveniently been 

set to zero such that the location of the tool path is not affected. 
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19) Introduction of a limited Math Expression interpreter to allow simple math operations in input fields. For 

example, it is sometimes required to add or subtract a value, such as shown below where the angle of “21.30.00” is 

increased by “0.5”; HyGEARS interprets this as 21.5 to which 0.5 is added. 

  

Some basic rules to follow: 

• For DDMMSS angles, the SS portion must have 2 digits; for example, 3.05.03 is Ok; 3.05.3 is not; 

• The + - * / operators are supported; 

• The operator + - * / must be followed by a value; if the integer portion of the value is less than 1, then a 0 

must precede the decimal point; for example, “5.2+0.5” is Ok; “5.2+.5” is not; 
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• operations within parenthesis are not accepted; for example, 5.2 + 0.5 is Ok; 5.2 + (0.5 * 2) is not; 

• Only 1 operation at a time; for example, “5.2+0.5” is Ok; “5.2+(0.5 * 2)” is not. 

20) In Corr-RE mode, for the [Corr] and [RE] function buttons applied to generated spiral-bevel and hypoid gears, the 

Helical Motion is now used as an additional degree of freedom to control tooth bias (or warping) if, and only if, the 

reference machine used is of Phoenix type. This allows for much better control of tooth warping sometimes found in 

Spread-blade teeth. 

21) In Corr-RE mode, for the [Corr] and [RE] function buttons, it is now possible to tell HyGEARS to “drop” some points at 

the bottom of the CMM grid. When undercutting is present at the bottom of the tooth, or if the bottom line of the 

measurement grid is near the fillet line, divergence can occur when HyGEARS is looking for the solution. When 

divergence occurs, the results displayed on-screen clearly show that something is not correct, and the cause is usually 

because the bottom line of the CMM grid is too close to the Fillet line. In such a case, HyGEARS can be told to drop, 1, 2, 3 

lines at the bottom of the grid, such as to use the lines which are further away from the Fillet. 

By default, this value is set to 0; it cannot exceed N-2, where N is the number of lines / flank in the CMM grid, such that at 

least 2 CMM grid lines are always conserved. 

 

22) In Corr-RE mode, introduction of a new criterion to Correct / RE the tooth flanks: Twist. Twist is defined as the 

curvature along the diagonal from (figure below): 

1. Concave Flank:  Toe Tip to Heel Bottom 

2. Convex Flank: Toe Bottom to Heel Tip 

The Ct value in the figure below gives the calculated amount of Twist 
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For example, figure below, selecting 2nd Order with Crowning, the following result is obtained for RE; one can see that 

along the diagonals, some significant curvature remains. 

 

By contrast, adding Twist to the selection yields the following result where it is clear that the curvature along the 

diagonals has been almost entirely eliminated.  

 

Twist is available only if the reference machine is a Phoenix. 
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22) When using the [Corr] (Closed Loop) or [RE] (Reverse Engineering) functions, when calculations have completed and 

the “Ok” button is clicked, HyGEARS now automatically appends “_CORR” or “_RE” at the end of the HyG file name such 

as to force a “clean” use of file names. In addition, for Closed Loop (i.e. [Corr] function button), the renamed HyG file is 

automatically saved in the source folder such as to avoid “forgetting” to save the file after Correction is completed. 

A message is then displayed on screen to inform the user of what happened. 

a) [RE] (Reverse Engineering): 

 

 

 b) [Corr] (Closed Loop): 

 

 

 

 

 



 
40 

23) In Geometry mode, the optional DXF Export function now allows 2 more options for the Tooth Section: 

 

• the # Teeth to be exported in the DXF file can be imposed; minimum = 1, maximum = Z; 

• Stock, positive or negative, can be imposed; this can be useful for wire cutting of an internal gear or spline. 

 

24) Machine settings for non-generated gears, i.e. Formate, now include Work Offset on Phoenix machines. 

 

 

25) In Splines, the external (male) member of a spline set can now have a circular end at Heel, as shown below. The 

radius of the circular end at Heel is entered in the Blank data page of the Pinion Summary editor ([Pin] function button). 
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26) For bevel gears, the Blank Child Window now displays the Front Crown to Mounting Distance (Fc-MD) rather than 

the Front Crown to Hub (Fc-Hub) as this is deemed a more useful value to locate the part in CnC manufacturing. 
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27) For Beveloid, Face and Cylindrical gears, the Blank Child Window now displays the Whole Depth of the tooth. 

a) Beveloid Pinion / Gear: 

 

 
b) Face Gear: 

 
b) Cylindrical Pinion / Gear: 
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28) When importing CMM results, HyGEARS now displays intermediate values within the gird in integer numbers, such 

as to allow better interpretation of the displayed results. Below, the intermediate values are rounded to the nearest µm. 

 

 
 

29) When importing CMM results, HyGEARS now maintains the CMM type and displays the IB and OB results in the same 

position as on the CMM display in order to ease comparison. 

 

30) When creating a CMM target file for the Klingelnberg P machine, HyGEARS now ensures that the mid-points of the IB 

and OB grids are exactly at the same radial and axial locations, in order to make thickness errors consistent. 

 

 
 

 

31) In Help -> About HyGEARS …, the IP# of the current computer is now displayed. 
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32) When the “Save As” function is used to save the current geometry as a Klingelnberg ND file, it is now possible to tell 

HyGEARS whether to use the Theoretical or Actual tooth root by specifying which Root Apex to Crossing Point, i.e. 

RApxXp, is to be used. 

 

 
 

33) When creating a New Geometry of Straight Bevel [Generated] type, the “Differential Gears” option is now offered.  

 

When this option is selected, the usual Depth Factor (Gear), Addendum Factor (Gear) and Clearance Factor are no longer 

available and the default Gleason tooth proportion factors for differential gears are rather used where (units: inches): 

 

• Mean working depth  Hk =  1.600 / DP 

• Mean whole depth      H  =  1.788 / DP + 0.002” 

• Clearance                       C  = 0.040 “ 

• Gear outer addendum  aoG   = 0.430 / DP  + 0.370 / (DP *( Z2 / Z1)2) 

• Pinion outer addendum  aoP = H - aoG  
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• Gear outer dedendum  boG = 1.788 / DP – aoG 

• Pinion outer dedendum  boP = 1.788 / DP – aoP 

 

  
 

It is also possible to select on which of the Pinion and/or Gear lengthwise Crowning will be applied by selecting “P. Len 

Crown.” for the Pinion and “G. Len Crown.” for the Gear.  

 

 
 

34)  The Circular Pitch has been added to the Blank section of the Summary ([SumX], [Summ] and [GSum] buttons). 
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35) The Blank definition window for Straight bevel gears now includes the following new possibilities: 

 

a) The Tip Chamfer may be defined as a radius by selecting the Radius option; 

 
b) The Outer Cone Distance may be modified; it appears in light blue below; 

c) The Toe ID may be imposed; when checking “Cropped ID” below, the relevant field becomes available; the Toe ID 

must be larger than the current value and smaller than the Toe OD; 

d) The Heel may be cropped by checking the “Cropped Heel” option; the relevant field then becomes enabled and a 

value larger than the current Crown to Xp may be entered; 
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36) When creating a new Face Gear (New Geometry), it is now possible to impose the # teeth on the gear shaper. By 

default, this would be equal to Z1 + 1, i.e. Z pinion + 1; however, increasing this value now allows imposing more 

crowning to the gear member, if required. 

 

 
 

 

37) When creating a new Hypoid gear set, it is now possible to impose the spiral angle on the gear rather than on 

the pinion. Until now, for Hypoid gears, the spiral angle had to be imposed on the pinion, which is usually, but not 

always, known. 

a) 

b) 

c) 

d) 
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As shown in the following figures, if the Spiral Angle field for the pinion is left blank and that of the gear is filled, 

HyGEARS will take the gear’s value as the target and find the pinion spiral angle that matches the desired gear value 

for the given set of parameters. 

 

For example, the following input data will cause HyGEARS to create a Hypoid gear set where the pinion spiral angle 

is 45º and that of the gear is 32.5º.  

 

   
 

It is also possible to obtain a similar result by entering the data as follows:  
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It is also possible to impose a minimum ID to the pinion at Toe, such as to satisfy bore conditions when the pinion is 

mounted on a shaft. If this value is imposed, HyGEARS will modify the OD such as to move the teeth out radially in 

order to satisfy the Mid Toe ID condition. 

 

38) The [BPat] function, used to develop the contact pattern (CP) on spiral bevel, straight bevel, Coniflex bevel and 

Beveloid gears, now allows targeting either the Pinion or Gear. 

 

By default, the Pinion is modified when developing the CP, and most of the possibilities are offered, as is shown in the 

figure below. 

 

 
 

By clicking on the “Develop Gear Machine” option, some of the available choices are disabled. While these choices are 

somewhat limited, they offer some degree of control over the CP by addressing only the Gear machine settings. 

For Coniflex, straight and spiral-bevel gears, the Horizontal and Vertical positions of the CP, plus the Backlash, are 

available. 
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For Beveloid gears, the Horizontal position of the CP, plus the Backlash, are available. 

 

 
 

39) In User mode, for the “Tooth” Child Window, addition of the [TThk] function button which can be used to obtain the 

transverse chordal tooth thickness at any combination of Radial and Axial position. 

 

When the “Tooth Thick.” Input window is displayed, the default location is at the Mean Point, i.e. mid face-width on the 

Pitch cone or cylinder. 
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40) In the Summary editor ([Pin] / [Gea] function buttons), for all bevel gears, addition of the “Ref. Vals” button to allow 

entering / editing the Reference Pressure and Spiral angles. 

 

 
 

When clicked, the Nominal/Reference Values window is displayed where the default values can be edited. These include: 

• Outer Cone Distance, 

• Face Width 

• Spiral Angle 

• Pressure Angle IB 
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• Pressure Angle OB 

 

The Nominal Spiral and Pressure angles are used in the Graphic Summary ([GSum] function button) to calculate the 

Transverse, Radial and Axial loads. 

 

41) In User mode, for the “Tooth” Child Window of Straight bevel gears, addition of the [DMld] function button which 

instructs HyGEARS to display a series of axial vectors, // to the axis of rotation, and originating at different axial locations 

on the tooth profile. This function is useful to establish if there is sufficient clearance to allow “demolding” a part 

manufactured by Powder Metallurgy, Forging or Injection. 

 

At Toe, a series of values are given that indicate the minimum amount of clearance between the vector and the profile. 

The vectors change color along the face width to allow better visualization. 
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42) Addition of the Hirth Couplings (optional) to the list of HyGEARS geometries. A Hirth Coupling is a pair of non-

generated straight “bevel” gears with an equal number of teeth and a 180 ° Shaft angle. Tooth taper can be Uniform or 

Standard. The Tooth Thickness angles can be imposed – which imposes the effective tooth thickness - or left free by 

entering 0 and HyGEARS will define the proper values based on the required Backlash. The Helix Angle is always 0, and 

the teeth are non-generated which means any pressure angle can be accommodated. The figures below show the 

relevant input screens to create a Hirth Coupling. 
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The figure below is really a “cogged teeth coupling” where the pressure angles are null and the Thickness Angles are 

imposed at respectively 6.5° and 7° for the “Pinion” and “Gear”. Given the imposed Thickness Angles, backlash results 

which can be seen as a separation between the teeth. 

 

  
 

The next figure is a more standard Hirth Coupling, where the teeth are tapered, the pressure angle is 20° and the 

Thickness Angles have not been imposed in which case, the imposed Backlash of 0 mm is enforced and we can see that 

there is no space between the teeth. 

 

  
 

43) Addition of the Spurniflex gears (optional) to the list of HyGEARS geometries. A Spurniflex gear is a spur gear cut 

using a Coniflex dish type cutter, hence the names Spur and Coniflex contracted into Spurniflex.  Generation on a 5Axis 

CnC machine is therefore possible, with good cycle times. 
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Spurniflex gear sets can take several different arrangements: 

 

• Parallel axes, like conventional spur gears; 
backlash is therefore controlled by the center distance. 

 

 

 

 

 

 

 

 

 

 

 

 

• Parallel axes, like conventional spur gears; however 
both the pinion and gear have the same non-null pitch angle 
opposed in sign such that the next Shaft angle is null.  
Backlash may be controlled by center distance and/or  
the axial position of the parts. 
 

 

 

 

 

 

• Concurrent axes, where both the pinion and/or  
 gear may have non-null pitch angles such that a non-null  

Shaft angle exists between the pinion and gear axes. Backlash  
is controlled by the axial position of the parts. 
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Because the teeth are generated using a dish-type cutting tool such as a Gleason Coniflex cutter, lengthwise crowning 

is controlled by the dish angle of the cutter and results in a localized contact pattern as is shown below. 

 

 
 

The root line of the teeth is circular, which has no significant downside as long as the facewidth is limited. A break-

edge may be applied at each end of the facewidth to prevent tip to root interference caused by the circular root line. 
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HyGEARS update – 09 September 2020 - Build 406.10 - 464 
 
1) In 5Axis, the “Center Slot” roughing cutting cycle, which was originally defined as Toe-Heel-Toe, has been expanded as 

“Center Slot – T-H-T” and “Center Slot H-T-H” such that the movement can now be initiated either at Toe (for the T-H-T 

variant) or at Heel (for the H-T-H) variant. 

 

2) In 5Axis, whenever a given Operation is selected by a double-click in the Process tab, the Cycle tab is now 

automatically displayed such that the user can review the cutting cycle directly unless the selected tool exceeds some 

limits and then the given tool tab is displayed. 

3) In 5Axis, for the CoSIMT DXF output (optional), the following inputs now allow defining the tool such that on a grinder, 

the dressing software can account for the desired shape outside of the actual grinding area. 

In particular, the following can be defined: 

• Y = 0 is at:    where is the radial 0 value; 

• Edge Length;    default is that in the CoSIMT definition; same value for both sides; 

• Wheel Thickness: thickness of the grinding wheel disk; default is 22 mm; 

• Flaring Angle:    from the grinding edge, the angle at which the dresser must travel to reach the ends of the 

grinding wheel disk. Same value for both sides. 
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4) In 5Axis, when the reference tool is a Shaper (for Face Gears for example), CoSIMT tools can now be defined with an 

Involute profile by clicking on the appropriate switch as is shown below.  

When doing so, the same Involute profile as defined for the shaper is used on the CoSIMT, but it is shifted radially such as 

to satisfy the entered OD. The only variables for this CoSIMT become:  

 

 

Edge Length 

Flaring Angle 

Wheel Thickness 
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• Out. Diameter: Outside diameter of the CoSIMT; 

• Edge Rad.: Edge radius; 

• D-Thickness: Change in thickness at the pitch circle; this can be used to ensure the CoSIMT does not  

simultaneously touch both tooth flanks when grinding such as not to suffer side movements. 

5) In 5Axis, for the Coniflex cutter DXF output (optional), the following inputs now allow defining the tool such that on a 

grinder, the dressing software can account for the desired shape outside of the actual grinding area. The following can be 

defined: 

 

 
 

 

Edge Length 

Flaring Angle Minimum ID 

Back Angle 
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• Y = 0 is at:  where is the radial 0 value; 

• Edge Length;  length of the grinding edge; default is 10 mm; 

• Back Angle:  back angle of the grinding wheel; 

• Flaring Angle:  from the grinding edge and the back side, the angle at which the dresser must travel to reach 

the ends of the grinding wheel disk.  

• Minimum ID: where the DXF stops; if zero, then the DXF stops at the end of the grinding edge. 

 

6) In 5Axis, addition of the ^G keyboard shortcut, which toggles the Detect Gouging option to On and Off. 

7) In 5Axis, Arbor tab, addition of the Chuck Length variable. “Chuck Length” moves the workpiece relative to the defined 

arbor without having to modify the arbor. This way, one can assess what change in Chuck Length is required to avoid the 

tool hitting the support arbor behind the workpiece. 

For example, figure below, the Face Mill cutter is seen quite close to the support arbor behind the part.  The Chuck 

Length is null in this setup.  

 

Because of the configuration of the installation, the Chuck Length must be increased by 10 mm to have better support. In 

this condition, we can see (figure below) that the Face Mill cutter will hit the support and an alternative approach must 

be found. 
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8) In 5Axis, when outputting the summary for a Process, i.e the [Summ] button as shown below, HyGEARS now adds the 

RPM, Vc and fz values to help review and assess each Operation part of the Process: 
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9) In 5Axis, the current position of the tool is now displayed as (Pos x/y), right after the tool coordinates, where x is the 

current lengthwise position number and y is the total number of Face Width Pts required, as shown below. This position 

corresponds to the position of the red dot indicating the current point in the milling cycle. 
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10) When clicking on the Machine Mode, HyGEARS now looks to see if Corrections were done to the pinion and the gear.  

When such a condition is found, HyGEARS selects the last correction found and toggles the machine settings summary to 

this correction. This has two advantages: 

• When calling 5Axis, the user cannot recut exactly the same part as what was done for the 1st cut, as it is assumed 

that if corrections are found, then the correction is what ought to be cut; 

• The user does not have to use the [Sele] function to identify the desired Correction. 

 

When Corrections are found, HyGEARS displays a message to inform the user that the machine state has been 

modified as shown below. 
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11) For the STEP output function, HyGEARS now offers additional choices, as shown below: 

• Output Encoding:   the output can be with the axis of rotation aligned along X, Y or Z; 

• Number of Teeth:   from 1 to the part’s tooth number; 

• Hub ID:       diameter of the hub under the teeth; the hub can now be included in the STEP file; this is 

especially useful when considering a differential Straight bevel gear where the tooth is cropped at Toe, resulting 

in a discontinuous tooth root line; 

• Tooth Gap:     instead of the tooth, the gap between the teeth can be outputted in the STEP file; 

• Closed Tooth Gap: whether the coordinates defining the tooth roots of each flank are left with a small space as 

digitized or have the same coordinates; note that a closed tooth gap does not imply that the lines bounding the 

tooth roots will be exactly // to each other since the fillet area on each tooth is different and in the STEP file is 

modelled as a B-Spline; 

• Combined  …:          whether the tooth front and back faces are continuous or separate B-Splines; works best 

when Tooth Gap is not used. 

 

For example, the following exports 3 teeth of a differential Straight bevel pinion where the tooth Toe end is cropped 

(since it is forged), along with its underlying hub of 15 mm internal diameter.  The front (light green) and back faces are 

continuous with the underlying hub. 
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12) In Machine mode, if the reference tool is a Shaper such as for a Face Gear, the [DxfS] function button is displayed if 

the DXF option has been purchased. Clicking on the [DxfS] button generates a Dxf file containing the coordinates of the 

shaper tool. 

 

 
 

Import of the shaper Dxf file in a CAD software generates the desired shape, as is shown below. 
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13) For Straight bevel gears, in Corr-RE mode, when calling either the [Corr] or [RE] functions, HyGEARS now offers the 

possibility to select how Pressure angle is controlled. Choices are: 

• Roll Rate (i.e., ratio of roll) 

• Blade Angle 

 

 

14) For bevel gears, in Geometry mode, HyGEARS now displays in blue the contour of the theoretical tooth as defined 

by: 

• the Ref. Face Width value; 

• the F.Apex to Xp value; 

• the R.Apex to Xp value; 

• the Root Angle value. 
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This allows assessing the differences between the theoretical and actual teeth which, of course, affect the tooth 

bending strength model. 

15) For Coniflex bevel gears, it is now possible to impose the desired Transmission Error (TE) at the transfer points. Of 

course, then this gearset cannot be cut on a conventional Gleason machine since Modified Roll, used to control the TE, is 

not available in the mechanical machines. 

 

When creating a New Geometry of Coniflex type, the General data page now offers inputting the desired TE in µRad, as 

shown below. TE is controlled by Modified Roll and it can therefore be practically any value. If left at 0, then the gearset is 

conventional and no modification is done to alter TE. 
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Therefore, the Higher Order changes for Modified Roll are then accessible in the Summary editor, as is shown below. 
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16) For Straight and Spiral bevel gears, Tip Relief is now offered. Tip Relief is accessed from the Summary Editor, TopRem 

data page, as shown below. The following values can be edited: 

 

• Blade Height:  height of the cutter blade; by default, equal to the sum of tooth depth at Heel; 

• Tip Relief Height: distance from the upper part of the blade where Tip Relief begins; 

• Tip Relief Angle:  if Tip Relief is linear, then an angle is entered here; 

• Tip Relief Radius: if Tip Relief is circular, then a radius is entered here.  

 

     
 

17) In Corr-RE mode, the tooth thickness error is now given in the display area, as shown below, rather than in the 

description text line at the bottom of the display as was the case before. 

Blade Height 

Tip Relief 
Height 

Radius 

Angle 
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18) In TCA and LTCA modes, when using the [Grid] function, the calculated backlash is now displayed for each 

combination of E-P-G etc. pinion and gear positions. This allows a better idea of the acceptable pinion and gear positions. 

 

In addition, negative backlash values are displayed in red to enhance assessment. 

 

 
 

19) When importing data from a Gleason Spa file, HyGEARS now looks ahead to see if Final Cut and Hard Finish data is 

present in the file. If so, the user is presented with the choice of what to import and the resulting HyG file name adds the 

relevant data type. 
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For example, figure below, both Final Cut and Hard Finish data are found in a Spa file. The user is thus offered which 

variant is desired. 

 
 

Depending on the user’s choice, if the Spa file name was 11x39.spa, the resulting HyG file name will be: 

 

• 11x39_FinCutFromSPA.hyg  

• 11x39_GrindFromSPA.hyg 

where either “FinCut” or “Grind” is added to identify the imported data. 

20) In TCA mode, when using the [E/P] function, HyGEARS now detects if CMM data is used to calculate the kinematics. If 

so, the P and G values will be used to locate the contact pattern (CP) where desired rather than E and P since in an actual 

gearbox, the E value cannot be changed.   

For example, the following CPs are obtained using the CMM data for a spiral bevel gearset in nominal position, i.e. 

with E = P = G = 0. 

 

If we attempt to improve the CP on the Gear Convex-IB flank, the following is obtained and can be used in an actual 

gearbox. 

• E = 0 

• P = 0.06 

• G = -0.02 
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21) Face Gear design has changed: you can now impose the Profile Shift factor on the shaper and on the pinion, but that 

of the gear is a consequence of both the selected shaper and pinion. 

 

 

   

A new value, called the FC.Xp, can also be entered. This value is the distance between the axis of the mating pinion and 

gear tooth tip at Toe. The requested FC.Xp value affects gear tooth depth and thus also the contact ratio. 

 

As HyGEARS develops the requested Face gearset, if the pinion Topland is found to be much different than the gear fillet 

tooth gap width at mid-face, or if the gear fillet tooth gap width at mid-face is null or negative, then a message such as 

below is issued to check whether it is accepted to modify the gear tooth proportions in order to obtain an acceptable 
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gear tooth. 

 

The display of the Face gear has also changed to incorporate more installation info, as is shown below. In particular, 

the following values are given: 

• C.Xp: distance between the mating pinion axis and the gear tooth tip at Heel; 

• FC.Xp: distance between the mating pinion axis and the gear tooth tip at Toe; 

• P.Xp: distance between the mating pinion axis and the pitch point on the gear; 

 

 

22) CMM Nominal: when comes the time to output the defined CMM Nominal, some CMMs such as the Klingelnberg P 

machine require up to 4 files, and it is tedious to have to Select, Save, Delete the window with the text, and move on to 

the next output.  
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The [Save] button calls the output from the [Outp] button, saves the content of all the generated text windows with 

CMM data, and then deletes the text windows, all in one Click. A real time saver. 

 

23) In User Mode, for the Path of Contact Child Window (in Kinematics), when the display of the Principle Curvatures is 

toggled On by clicking on the [NoPD] button, the [NoCur] button is displayed immediately below the [PDir] button. The 

[NoCur] button can then be toggled into [Curv] which tells HyGEARS to display also the radii of curvature at different 

points along the PoC. 

 

For example, left figure below, the principle directions are displayed as K1 and K2, where K1 is the direction of the major 

principle curvature and K2 is the direction of the minor principle curvature. The same are displayed in the right figure, but 

in addition the value of each radius of curvature is given. 
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24) When creating a New Straight Bevel (Generated) gear set (New Geometry), several values can now be imposed to 

facilitate the initial design.  

 

Referring to the figure below: 

• Crowning [mm] / 5[mm]:  the desired amount of crowning per 5[mm] face width, pinion and gear; 

• Thickness @ Mid-Face:  the desired tooth thickness at mid-facewidth; ignored if 0; 

• Thickness @ Heel:  the desired tooth thickness at Heel; ignored if 0; 

• Edge Radius:   the desired cutter edge radius; ignored if 0. 
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25) When creating a New Geometry, Spiral Bevel / Zerol / Hypoid, the Edge Radii can be different on the IB and OB 

blades even for completing processes. 

 

 
 

26) In Corr-RE mode, the thickness error value has been moved from the text line at the bottom of the display to a more 

visible part of the screen, as shown in the figure below. 

 
 

27) In Geometry mode, addition of the ^D keyboard shortcut. For Beveloid gears, Shapers and Skiving tools. ^D toggles 

the Blank display between the Side and Front views, the latter providing the diameters at tooth mid-face as is shown 

below. 
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28) In Machine mode, addition of the [Corr] And [RE] functions for Face Gears. 

 

29) Addition of Tip Relief to the blade definition of Spiral-bevel gears. This is accessed through the TopRem data page of 

the Summary Editor – [Pin] and [Gea] function buttons. 

 

 
 

 

 

 

 

 

 

 

 

 

When non-zero TopRem Angle and Radius are both entered for one blade side, preference is given to Circular TopRem, 

i.e. the TopRem Radius. The same rule applies for Tip Relief when non-zero values are both present: Circular Tip Relief is 

given preference. 

Blade Height 

Tip Relief Height 

Tip Relief Radius 

Tip Relief Angle 

I.B. O.B. 

^D 
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HyGEARS update – 27 September 2021 - Build 406.20 - 464 
 
1) In 5Axis, the MultiPass cycle is now allowed in the fillet for CoSIMT tools. 

 

 
 

2) In 5Axis, Process tab, when an Operation is selected in the Available Operations list, a right mouse-click offers to 

Duplicate or Rename the selected Operation, in addition to the already existing “->”used to transfer the selected 

Operation from the Available list to Process Content list, and “Delete” to delete the selected Operation.  

 

If the right mouse-click is done on a selected Operation in the Process Content list, then only the “Rename” option is 

offered, along with the “<-“ used to transfer the selected Operation from the Process Content list to the Available 

Operations list. 
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When either “Duplicate” or “Rename” is selected, an input window is shown where the desired name is to be entered. 

 

 
 

3) STEP output: the STEP output interface has been expanded and now allows to impose that the fillet and tooth flank 

surfaces be encoded in separate B-Splines, and also allows specifying the # points desired along the tooth Face width, in 

the Fillet and on the Profile. 
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4) The Cutter Blade is now displayed in a revised format, with more details. The Cutter Blade is also added to the 

Graphics Summary ([GSum] function button). 

 

 
 

5) When defining the CMM Nominal - [Nom] function button – the Probe Sphere can now be displayed, as is shown 

below, by entering the diameter of the used probe and by checking the “Show Probe Ball” option. 

 

This allows one to size the required probe prior to making the actual measurement. 

 

In addition, the Toe and Heel widths of the tooth gap at the fillet line are now given to quickly gage the correct probe 
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size. 

 

 
 

6) When creating a new bevel gearset, until now HyGEARS would limit the shaft angle to prevent the pitch cone angle of 

the gear from reaching 90 deg, where the tangent becomes infinite. This limit is now removed. 

 

7) When editing a Cyclo Palloid geometry with the Summary Editor, on the Other data page, the desired tooth thickness 

can now be entered directly. HyGEARS will then adjust the cradle angles of the IB and OB to match the entered thickness. 
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8) When editing a geometry in metric units with the Summary Editor, on the Blank data page, HyGEARS now displays 

both the Outer Transverse Module (i.e. Module) and the Mean Normal Module (i.e. mn) as shown below. 

 

 
 

9) In the outputted Summary – [Summ], [GSum], [SumX] function buttons – the section where the diameters were given 

has been removed and replaced with more tooth thickness details, as shown below. 

 

The Normal and Transverse thicknesses are given at the Mean Point and at Heel; in addition, the Axial and Radial 

positions of the Mean Point and Heel Point are provided for reference.  
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10) In 5Axis, the Short Header now includes the machine used for the current part program. 

 

 
 

11) In 5Axis, machines using the Fanuc controller can now be told to “Preset ABC Angles”. In short, some controllers 

pretty much come to a crawl when the X Y Z coordinates and A B or B C or A C angles are changed simultaneously. This 

can become a serious cycle time issue the changes in the A, B and/or C angles are large (for example after tool retract and 

when indexing for the next tooth gap) and the controller comes to a crawl. 

 

In order to use this feature, 

• The machine definition must be adjusted to use this feature; 

• In the Output Format of the Cycle tab, the “Preset ABC Angles” option must be selected. 
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HyGEARS will then output 2 single lines of code to move the A, B and / or C angles individually in order to get good cycle 

time.  The moves can be either G00 – which is dangerous as it is the fast machine move – or G01 – which is 

recommended since the operator can slow down the machine when testing an operation. 

 

 
 

 

12) In 5Axis, when deburring / chamfering the Toe and Heel tooth edges, HyGEARS now extends the tooth OD such that 

a small clearance accounting to 25% of tooth depth is provided; this allows for faster plunge feeds. 
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13) When using the “Save As” function, HyGEARS now offers to save the geometry in the format of an earlier HyGEARS 

release.  This is based on the file version number as shown below. 

 

 
 

The following table gives the equivalence between the HyGEARS version and the HyG file version. 

 

HyGEARS Version “HyG” file version 

 
406.20 
406.10 
406.00 
405.90 
405.80 
405.70 
405.60 
405.50 
405.40 
405.30 
405.20 
405.10 

 
464 
464 
463 
462 
461 
461 
461 
460 
459 
459 
459 
458 

Clearance 
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405.00 
404.90 
404.80 
404.70 
404.60 
404.50 
404.40 
404.30 
404.20 
404.10 
404.00 

457 
457 
457 
457 
457 
457 
457 
457 
457 
457 
457 

 

 

14) When editing a cylindrical gear, HyGEARS now offers different Generating Pitch Diameter and Crowning values for 

the Left and Right tooth flanks, thereby opening the door for Closed Loop and Reverse Engineering. 

 

 
 

 

15) HyGEARS now sports Closed Loop and Reverse Engineering (RE) for cylindrical gears, including Face Gears. For the 

[Corr] and [R.E.] to work, measurement data must be present and displayed. 

 

Both 1st and 2nd Order algorithms are offered; for 1st order, as is usual, pressure and helix angles are accounted for, plus 

tooth thickness. 
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For 2nd Order, tooth lengthwise Crowning is added. 

 

 
 

In both 1st and 2nd Order, the Machine tab allows selecting the control parameter for the Pressure angle, as shown 

below: 

• Roll Rate is equivalent to changing the Generating Pitch diameter; this is the most likely scenario and is 

therefore the default; 

• Alternately, the Blade Angle can be chosen as the control parameter; note that the tool is then changed. 

For tooth lengthwise Crowning, only the Crowning value can be selected. 
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15) In 5Axis, when using the Detect Gouging feature (Machine/Tool tab), one can ask to have the gouging values 

displayed instead of the location where gouging is occurring. By default only the gouging locations are displayed. 
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16) In Machine mode, spiral bevel gears cut using completing cycles such as Duplex Helical, Spread Blade, or Formate, 

can now be converted to equivalent Fixed Setting cycles for the Convex and Concave tooth flanks. Doing this generates 

the same machine settings for both flanks, but using different cutters; therefore initially the Contact Pattern may have 

moved and the backlash may be different. Using the [BPat] function in TCA mode allows moving the Contact Patterns 

where desired. 

 

This function is not useful per se for manufacturing; however, it can prove useful if an unknown gear - whose 

manufacturing details are not known - is to be replicated by milling; Reverse Engineering a Fixed Setting part usually 

allows a very close fit. 
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For example, the spiral bevel gearset shown below has a Duplex Helical pinion. 

 

 
 

After converting the pinion from Duplex Helical to Fixed Setting, the TCA shows the following where HyGEARS has 

centered the CPs on the tooth flanks. 
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Using the [BPat] function in TCA mode allows moving the Contact Patterns where desired and the backlash back to its 

desired  value. 

 

 17) In Geometry mode, addition of the [TThk] function button, giving access to the Tooth Thickness function in which  

one enters the Axial and Radial locations of the point where the thickness is desired. 
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By default, tooth thickness is given at Mid-face as indicated by the [M] button at the right of the Axial Position; however, 

clicking on the [M] button toggles it to [H], indicating that tooth thickness is now given at Heel. For bevel gears, [M] and 

[H] are on the pitch cone. Entering any Axial and Radial value tells HyGEARS to calculate tooth thickness at the given 

position. 

 

18) In TCA mode, addition of the [Opp] function button used to invert the tooth hand of spiral bevel, straight and helical 

gears. The [Opp] button still appears in Geometry mode. 

 

 
 

19) In 5Axis, for Semi-Completing (SC) spiral bevel gears, addition of the Center Roll cutting cycle.  When generating SC 

gears, it is not uncommon to leave a ridge at the center-bottom of the tooth gap if the point width of the Face Mill cutter 

is significantly smaller than the tooth gap – see figure below. The Center Roll cycle is introduced to allow removing this 

ridge efficiently. 
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The Center Roll cycle moves the cutter to the center of the tooth gap; the cutting cycle is then calculated on the roll 

angles at the fillet limit of the tooth flank. Toe and Heel Clearances are generally NOT required, and although a soft 

plunge feed is recommended, cutting feed can be much higher than for the tooth flanks given very little material is 

removed. 

 

The “Center Roll delta position”, shown above, can be used to move the tool away from the Convex flank (+ value) or 

closer to the Convex flank (- value) should the center of the Point Width not be exactly where desired, as the 2 figures 

below show. 
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20) When creating a New Geometry, the mean normal module “mn” is now displayed for bevel gears, in order to 

facilitate relationship with data sometimes given in metric drawings. The mean normal module is derived from the 

already entered dimensions such as module, shaft angle, tooth number, face width and spiral / helix angle and is updated 

as any of these values is changed. 
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21) In the HyGEARS configuration (File -> Edit -> Configuration), for all bevel gears, it is now possible to tell HyGEARS to 

default to ISO or AGMA tooth proportions when creating a New Geometry; when HyGEARS is initially installed, this 

defaults to AGMA. The selection appears on the Units tab of the Configuration editor, as shown below.  

 

 
 


